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Chapter 1

Safety Information

Recommendations for Safe Operation
Follow these recommendations for safe operation of the device.

General Guidelines
•

Make sure that all personnel are properly trained before using the ManoScan®
system.

•

Perform the clinical procedure according to an established protocol as prescribed by
the responsible physician.

•

Make sure that all accessory equipment is certified to the respective IEC standards
(IEC 60950 for data processing equipment and IEC 60601-1 for medical
equipment). All configurations must comply with the system standard
IEC 60601-1-1. Anyone who connects additional equipment to the signal input part
or signal output part is configuring a medical system, and is therefore responsible
that the system complies with IEC 60601-1-1. If in doubt, consult your Given
Imaging representative.

•

Do not use this system in the presence of a flammable anesthetic mixture with air or
with oxygen or nitrous oxide. (The system contains a type BF applied part.)

Probe and Catheter Guidelines
•

Follow the on-screen instructions and those in this user guide to calibrate the probe
and verify its proper function before each clinical use. (See Step 2: Calibrating a
Probe on page 38 for HRM procedures).

•

When using the disposable sheath for an esophageal procedure, make sure that it is
secured to the probe to prevent accidental aspiration. Make sure that both the
catheter and the sheath are removed from the patient during extubation. It is unlikely
but possible for the sheath to slip off of the catheter during removal.

•

Do not use the disposable sheath for proximal gut studies or pressure-withimpedance studies.

•

If a disposable sheath is used: clean the probe and perform high level disinfection
before each subsequent use. Refer to the instructions included with each catheter or
probe.
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•

For ManoScan HRM procedures, do not immerse the probe in liquids beyond the Do
Not Immerse label on the probe. Immersion of the connectors or vent tube located at
the Y, near the proximal end of the probe, can damage or destroy the probe.

•

Handle the manometric catheter probe and ManoShield carefully to avoid even
minor nicks and cuts. The probe can be damaged by excessive gripping, bending, or
pulling. Hold the catheter with the same force you would use to hold a fragile object.

•

Do not disconnect the probe from the module by pulling on either the cable or the
probe. Grasp the probe only by its connectors when making connections.

•

Do not manipulate the probe using any endoscopic instruments. Such devices have
great potential for rupturing the outer catheter sleeve.

•

Never allow the probe to be bent in a radius less than 2.0 cm (0.75 in.) or pulled with
a force greater than 1 N. (equivalent to 0.1 kg or 0.2 lb). Tight bending can also
occur during clinical data collection if the probe becomes doubled back on itself. If
you see this condition, which is easily recognizable on the real-time display,
withdraw the catheter (see Step 6: Annotating the Study on page 41). Failures of the
probe due to excessive force or tight bending are not covered under warranty.

•

Do not use any probe that has cuts or openings in the probe body.

•

Do not keep the catheter in a detergent or disinfection solution for prolonged
periods. The catheter should remain in such solutions no more than 125% of the
time recommended by the disinfection manufacture to complete the disinfection
process. Prolonged disinfection soakings may permanently discolor the outer
covering and make it tacky to the touch.

•

Do not damage or scratch the external gold impedance sensor rings in the ManoScan
ESO Z impedance catheter.

•

Do handle the probe gently and assure that no objects are inadvertently placed on it
and that it is not pulled on or bent sharply during cleaning.

•

Do store the probe in a contamination-free and protected manner (for example,
using the provided storage case) not coiled tighter than a 15 cm (6 in.) diameter.

•

Avoid using electro-cautery and defibrillation equipment near the probe to prevent
damage to the probe or electronic circuits.

•

When inserting a catheter into the calibration chamber, to avoid applying clamping
pressure on a sensor element that could permanently damage it, make sure that the
catheters are inserted to the appropriate depth:
• Regular and small diameter esophageal catheters: to the labeled depth of 42–
45 cm (16.5–17.5 in.) into the calibration chamber.
• 3D esophageal catheter: to a minimum depth of 52–55 cm (20.5–21.5") into the
calibration chamber.
• High resolution anorectal probes: to just below the balloon fill tubes.

ManoScan

2

User Guide

•

To avoid excessive calibration shift and possible damage to the probe, do not
manually apply pressure greater than 100 mmHg. When determining whether probe
sensors are operating, observe the output signal while applying light pressure (< 100
mmHg). Do not apply pressure with a fingernail or sharp object, which may create
high localized stress. When applying uniform pressures, such as with an air pressure
chamber, do not apply pressures greater than 300 mm Hg.

•

The motility probe and system are temperature compensated, but not compensated
for thermal shock. A transient response (approximately one minute) may occur
when a motility probe first experiences body temperature. When giving a patient
liquid to swallow, use tepid (near body temperature) liquids to prevent thermal
shock.

Other ManoScan Equipment Guidelines
•

Follow product cleaning instructions for the cart, modules, catheter case and tray,
and the external parts of the calibration chamber (see Cleaning and Disinfecting on
page 11).

•

Clean the calibration tube, seal knob, seal ring, and any other reusable calibration
accessories at least once per month in a laboratory dishwasher with water
temperature not exceeding 82o C (180o F) (see Calibration Chamber Care on
page 12). Dry the clear tube internally with a clean non-scratching cloth to prevent
water spotting.

•

If the calibration chamber is contaminated via introduction of a non-disinfected
probe or other means, disinfect the tube and seal knob using the same guidelines as
for the probe. Replace the white or translucent seal grommet (see Calibration
Chamber Care on page 12). Disinfect the calibration housing using topical spray.
Minimize the amount of spray used so that the clear pressure tubing remains dry.
Clean the calibration tube gasket and seal knob grommet with hot water not
exceeding 82° C (180° F) and mild soap. Do not soak or clean the calibration tube
gasket and seal knob grommet with any Cidex product, as these disinfecting
solutions can cause the gasket material to deteriorate.

Software Guidelines
•

Remember that the anatomical depictions relative to the pressure signals provided in
the software are rough approximations. If using the anatomical depictions, you are
responsible for their proper positioning relative to the data.

•

Do not add any unauthorized software to the system.

ManoScan
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Indications for Use
The ManoScan system provides mapping of pressures and, optionally, impedance within
organs of the human gastrointestinal tract. These include the pharynx, upper esophageal
sphincter (UES), esophagus, lower esophageal sphincter (LES), stomach, sphincter of
Oddi, small bowel, colon, duodenum, and anorectal organs. It is used in a medical clinical
setting to acquire pressures and then store the corresponding data for visualization and
analysis. The real-time data as well as the analysis information can be viewed by
medically-trained personnel for diagnostic and analytic purposes. The ManoScan HRM
modules provide high-resolution and/or 3D (three dimensional) display of the pressure
and impedance data. The ManoScan CLT module provides conventional line trace
mapping of the pressure data and can be used as a stand-alone system or as a module of the
ManoScan High-Resolution manometry system.

!

Warning
To avoid risk of electric shock, this equipment must only be connected
to a mains supply with protective earth. Do not position the system in a
way that would make it difficult to disconnect the system from the mains
power supply.
Do not modify this equipment in any way.
Do not use the device around anesthetic gases mixed with air, oxygen,
or nitrous oxide. Danger of electrical ignition.
The device is not compatible for use in an MRI magnetic field.
Electrical equipment for medical use requires special EMC precautions
and needs to be installed and serviced according to the EMC
documentation of the device.

!

Caution
Portable and mobile RF communication equipment can affect electrical
equipment for medical use.

Given Imaging is only responsible for the reliability and performance of the device if the
following guidelines are strictly observed:
•

Only authorized Given Imaging personnel perform all repairs and modifications.

•

The device is only used for the intended use and in accordance with instructions in
this documentation.

If these guidelines are violated, the warranty will be invalid.

ManoScan
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Contraindications
The use of the ManoScan system for pharyngeal/esophageal motility study and proximal
gut (gastric/duodenal) manometry is contraindicated for the following:
•

patients with an inability to tolerate nasal intubation

•

patients with significant bleeding disorders for whom nasal intubation is
contraindicated

•

patients with a known esophageal obstruction preventing passage of the instrument

The use of the ManoScan system for anorectal manometry is contraindicated for patients
with known anal stricture/obstruction preventing insertion of the instrument.

Adverse Events
•

Nasal passage insertion: potential adverse events associated with the use of this
system and catheter insertion into the nasal passage may include:
• Discomfort, nasal pain, minor bleeding, runny nose, throat discomfort, irregular
heartbeat with dizziness, and perforation.
• In rare instances, the catheter may be misdirected into the trachea causing
coughing or choking, the catheter may curl during intubation, and catheter
position may move during the procedure.

•

Anorectum insertion: potential adverse events associated with the use of this
system and catheter insertion into the anorectum may include:
• Discomfort, pain, minor bleeding, irregular heartbeat with dizziness, and
perforation.
• In rare instances, the catheter may curl during insertion and catheter position may
move during the procedure.

•

Medical, endoscopic, or surgical intervention may be necessary to address any of
these complications, should they occur.

•

The system is not compatible for use in an MRI magnetic field.

Intended Audience
You must have a thorough understanding of the technical principles, clinical applications,
and risks associated with the ManoScan System before using this product. Read this entire
document before using the system for the first time.
Make sure that only trained personnel, familiar with all of the ManoScan System
operating procedures, use the system.
Manometric catheter placement requires skill and experience in esophageal and anorectal
catheter intubations and insertions. Clinicians lacking the required experience and
proficiency should not use the system.
ManoScan
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Chapter 2

Product Overview

Introduction
The ManoScan products provide hardware and software for performing gastrointestinal
(GI), sphincter of Oddi, and colorectal manometry.

Modules
HRM Modules
The ManoScan HRM modular system allows you to select the high resolution manometry
system configuration that best meets your clinical needs. Throughout this user guide, the
term ManoScan is used to refer to any configuration of the ManoScan modular system.
•

All configurations require the base A120 unit. This unit includes an electronic
control box that serves as the interface for acquiring pressure data from the probe
and provides the logic for controlling the system.

•

ManoScan Impedance module (Z) adds impedance measurement capabilities to
the ManoScan system. This module supports the use of esophageal manometric
catheters with impedance rings and provides additional clinical data from the same
clinical procedure. This configuration requires the base A120 unit plus the A200
unit, which includes an electronic control box that serves as the interface for
acquiring impedance data from the probe and provides a means for direct
communication with the host computer.

•

ManoScan 3D HRM module supports 3D catheters and probes for esophageal and
anorectal studies. The 3D catheters and probes measure circumferential pressure
using solid state sensors. When used in combination with the ManoScan HRM
module and software, this module enables 3D imaging of the esophageal and
anorectal anatomy. This configuration requires the base A120 unit plus the A300
unit, which consists of an A300 electronic control box that serves as the interface for
acquiring data from the probe, with the A120 control box providing the logic for
controlling the system.
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HRM Configurations
The system is supplied as either:
•

an integrated cart system (basic ManoScan), consisting of:
• a cart
• catheter probe
• A120 module
• computer
• external computer peripherals (keyboard, mouse, etc.)
• touch screen display monitor
• calibration chamber
• power isolation station
• ManoScan 3.0 and ManoView 3.0 software

•

a portable system integrated with a laptop PC

•

a stand-alone module that connects to a host PC

The software (ManoScan) acquires and synchronizes, as required, the data from each of
the control modules.
Each of these configurations (3D, Impedance) can be added to either the modular cart
system or the modular system.

HRM Modular System
In the modular system configuration, the modules interface with an external user-supplied
PC. The user shall ensure that the PC is in compliance with the governing safety standards
and meets medical grade power isolation requirements. A complete ManoScan modular
system consists of the following items:
•

manometric catheter probe

•

A120 module

•

calibration chamber

•

ManoScan 3.0 software



ManoScan

Note
Before ManoScan 3.0, there were two separate configurations:
ManoScan 2.1 ESO and ManoScan AR 2.1. ManoScan 3.0 merges all
functionality into a single software application.
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The following table shows the relationship between modules, software, and supported
catheters:
System or Module
Enhancements

Electronics

Modality

Software

Catheters

ManoScan HRM

A120 (base
pressure
module)

HRM: ESO

ManoScan 3.0

ManoScan ESO
(EAN)

ManoView ESO

ManoScan ESO
SD Regular (EAS)
ManoScan ESO
SD
Small (EPS)
HRM: AR

ManoScan 3.0
ManoView AR

ManoScan AR,
Regular (AAN)
ManoScan AR,
Small (APN)

ManoScan
Impedance

ManoScan 3D

A200
(impedance
module)

HRM: ESO Z

A300 (3D
module)

ESO 3D

ManoScan 3.0
ManoView ESO

ManoScan ESO Z
(EAZ)
(motility/ pressure
with impedance)

ManoScan 3.0
ManoView ESO

ManoScan ESO
3D (EAY)
(high definition
motility/ pressure)

AR 3D

ManoScan 3.0
ManoView AR

ManoScan
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Chapter 3

Setup and Connections

Introduction
Initial ManoScan system installation is provided by Given Imaging personnel or trained
and qualified distribution representatives. For portable systems, training includes
instructions on disassembly and setup. Software installation instructions are provided on
the software media cases.



Note
At the end of their useful life, all ManoScan modules and accessories
should be disposed according to local recycling and biological waste
procedures and regulations.

ManoScan HRM Installation and Configuration
Connections
ManoScan HRM (A120 module): Connections are provided on the front panel of the
A120 for the high resolution probes. The probe connections are color-coded and keyed to
prevent inadvertent swapping of the two connections. Align the red dots on the catheter
connectors to face upwards (12 o’clock position). See Figure 2 on page 11.
ManoScan Impedance (A200 module): The A200 Module adds an additional connector
to support the impedance signal input from the high resolution manometry with
impedance catheter. Align the red dot on the impedance connector to face upwards (12
o’clock position). See Figure 1 on page 10.
ManoScan 3D (A300 module): The A300 Module has two connectors to support the
three dimensional pressure signals from the 3D probes. The probe connections are colorcoded and keyed to prevent inadvertent swapping of the two connections. Align the red
dots on the catheter connectors to face upwards (12 o’clock position). The additional hose
port is for the AR 3D catheter balloon sensor connected to an external pressure reference
sensor, housed in the A120 module. Power is supplied to the A300 module by the A120

ManoScan
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module. The 3D pressure signal is relayed via the two hard-wired cables from the A300 to
the color-coded connectors on the rear of the A120 module.
Note
All modules act as USB peripheral devices; therefore, always turn on
the module before turning on the PC.


!

Warning
To avoid risk of electric shock, this equipment must only be connected
to a mains supply with protective earth. Do not position the system in a
way that would make it difficult to disconnect the system from the mains
power supply.

3D A300 module
Z A200 module

A120 module

Figure 1. Connections and interface features of the ManoScan HRM
modules

ManoScan
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When using the A120 module along with the A300 module and AR 3D anorectal probe,
follow the special air hose connection diagram in Figure 2:
Connect white Luers with white jumper.

USB port
power

connects to
colored Luers
on AR 3D
anorectal
calibration
chamber

connects to colored
Luers on calibration
chamber
Secure all T joints.

Figure 2. Air hose connections on A120/A300 combination when using
the AR 3D anorectal probe

Catheter Care



Note
The Centers for Disease Control (CDC) recommends the use of a
probe cover or condom to reduce the level of microbial contamination
when a probe cover is available. The CDC also recommends that all
catheters and probes be cleaned and undergo high-level disinfection
after each use or as otherwise permissible by region/country/institution
guidelines or standards where the product is being used.

The following information is supplied as an overview. Always refer to the instructions
provided with each Given Imaging manometry catheter and probes.
Cleaning and Disinfecting
Given Imaging does not disinfect probes prior to shipment. Proper disinfection of a probe
is the responsibility of the clinician conducting the procedure. Follow these
recommendations to clean or disinfect the probes without causing damage:
•

Do not use ultrasonic or other agitation while washing the probe. Do not autoclave
or use ionizing radiation. Do not use any products containing hydrogen peroxide or
glycerin to clean or disinfect the probe.

•

Do not use any strongly-alkaline cleaning agents such as Parson’s Soap or strongly
oxidizing agents such as peracetic acid or hydrogen peroxide. Disinfectants such as

ManoScan
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Endo-Spor, Sporox, and the Steris Washer use hydrogen peroxide and will damage
the probe.
•

Do not use synthetic detergents or petroleum-based soaps as these may be absorbed
by the silicone and subsequently leached out in prolonged use.

•

Do not pull on the outer sleeve of the catheter probe while cleaning. This can cause
bunching of the outer sleeve and potentially damage the probe.

•

Clean the ruled tubing and Y connector section of the probe with an antiseptic
towelette or germicidal disposable cloth (follow the manufacturer’s guidelines).
Given Imaging recommends the following cleaning cloths and/or towelettes:
• PDI, Sani-Cloth® Plus, germicidal disposable cloth
• Benzalkonium antiseptic (BZK) towelettes
• PDI, Super Sani-Cloth® Plus, Germicidal Wipes
• Accel PREVentionTM surface disinfectant (applied to sterile wipe, cloth, or gauze)

Usage Tips
•

Before immersing the catheter in reprocessing solutions, carefully inspect its
exterior for tears or damage. This minimizes further damage of the catheter to parts
not designed for fluid exposure.

•

Do not immerse the probe beyond the Do Not Immerse demarcation line near the
proximal end of the probe (the end with the electrical connectors and vent orifice).
Doing so can damage or destroy the probe.

•

Do not use silicone fluid or grease to lubricate the passage of the probe through the
nares or anus as these materials may swell and weaken the tubing and consequently
compromise the integrity of the outer section of the probe.

Calibration Chamber Care
Disassembly for Cleaning
The calibration tube must be removed for cleaning:
1.

Loosen the tube seal collar approximately one turn.

2.

Pull the tube down.

To reassemble the calibration chamber after cleaning:
1.

Slide tube upwards in housing.
If tube does not seat firmly, remove seal collar, thread tube through internal o-ring,
and replace collar.

2.

Tighten collar.

ManoScan
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Test collar tightness by pulling down lightly on the tube; the tube should not move.
seal grommet
seal knob

tube seal
collar
calibration
tube

calibration
chamber
housing

Figure 3. ManoScan AR 3D calibration chamber disassembly for
cleaning
seal grommet

seal knob
calibration
chamber
housing
tube seal
collar

calibration
tube

Figure 4. ManoScan calibration chamber disassembly for cleaning
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Maintenance
1.

Leave the calibration chamber un-tightened when not in use.

2.

Replace seal grommets every six months.

Connecting to Your HIS (Hospital Information System)
This information is intended to be used by the IT professional responsible for maintaining
the HIS.
ManoScan supports interfacing with an HIS. This allows the import of patient information
into ManoScan and the export of the study report from ManoView.
patient information via
*.imp (import) file

ManoScan
software

HIS

patient info via
*.exp (export) file
and *.pdf (report)

ManoScan
file (data +
patient info)

ManoView
software

Figure 5. The data workflow between the ManoScan system and the HIS

ManoScan software accepts the patient information from an import file (*.imp).
ManoScan looks in the folder specified in Folders > HIS Import every time it starts, and
adds the patients scheduled for procedure to the Patient Manager (accessible from Patient
Information screen). Patient information is exported by ManoView to the HIS as an export
file (*.exp) file, and the study report is exported as a PDF file (*.pdf).
Here is the file structure for both the import and export file:
<study>
<patient>
<dob>1954-11-23</dob> //yyyy-mm-dd
<name>
<first>Ralph</first>
<last>Jefferson</last>
<middle>H</middle>
</name>
<gender>1</gender> //1 = Male, 0 = female
<height>1701</height> //in mm
<id>C98349A2</id>

ManoScan
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<weight>70306</weight> // in gms
</patient>
<procedure>
<indications>Swallowing Problems</indications>
<procedure>Esophageal Manometry</procedure>
</procedure>
</study>

ManoScan
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Chapter 4

Introduction to the ManoScan
Software

The ManoScan software application acquires and synchronizes the data from each of the
control modules.

Software Initiation
When ManoScan starts, the Select Source screen is displayed. This screen is the main
interface to install a catheter, select a catheter to be used for study, or review a saved study.
The screen displays options appropriate for the hardware module connected to the system
(HRM, or None) (see following figure).
You can select a procedure to simulate data for demonstration and tutorial purposes.
Simulation can be viewed for Background and Event data. The Background plays in a
loop (it restarts automatically after ending), while the Event plays only once per
command.

Figure 6. Select Source screen

ManoScan
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The Procedure Screen
Once a source is selected, the interface changes to display controls appropriate for that
type of procedure.

7

6
3
1

2

4

3

5

Figure 7. Procedure Screen (labeled areas are defined below)

ManoScan

1

Main Display: displays real-time data (see The Display Environment on
page 20).

2

Profile Display: displays the real-time data.

3

Left, Right, and Bottom panels: buttons for manipulating display, adding
annotations, or performing other specialized functions.

4

Study Information panel: displays patient and study information. Clicking
text in this panel opens the Patient Information screen.

5

Profile Controls: buttons to manipulate display modes on the Profile Panel.

6

Guide instructions.

7

Menu.
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Menus
File Menu
The File menu contains options for creating, opening, and saving study files:
Menu Option

Action

New Patient / Patient Info Opens the Patient Information screen to input new or edit existing
patient information.
Close / Save Current

Opens Save Current screen to save study if you don’t follow the
Guide wizard until the end. Studies are automatically saved in the
Temp folder.

Review Patient File

Opens the Study Manager.

Print

Prints a basic report with screen captures and patient information.

Exit

Closes the application.

Setup Menu
The Setup menu contains options for saving and applying information about the current
display.
Menu Option

Action

Load and Save Settings

See Saving and Loading User Preferences on page 20.

Guide

Allows selection of a Guide if multiple Guides are applicable for a
procedure.

Channels

Applicable only to HRM procedures. Allows selection of channels
seen on Main and Profile Display.

Site Information

Opens Set Site Information screen for saving site information with
the file.

File Naming

Opens Setup File Naming screen for defining the name format of
study files.

Units

Opens Setup Units screen for defining the unit types for different
parameters.

Languages

Allows selection of language for the program interface.

Folders

Opens a menu for selecting the default folder location for:
•
•
•

Study Repository: folder to which the study file is saved. The
Study Manager scans this folder to populate the study list.
Report: folder to which the report file is saved.
HIS Import: folder from which patient information is retrieved
and displayed in the Patient Manager screen (see Connecting
to Your HIS (Hospital Information System) on page 14 for
details).

Install Probe

Opens Install Probe screen for installing new HRM probes.

Select Source

Opens Select Source screen for selecting a new source of data
input.

ManoScan

18

User Guide

Tools Menu
All tools can be accessed through the Tools menu:
Menu Item

Explanation

Calibration

Opens the Calibration screen (see Step 2: Calibrating a Probe
on page 38).

Calibration Utilities

Opens the Calibration Utilities screen.

Maintenance

Walks through pressure calibration and in-vivo calibration
sequences. This provides an alternative to using the In-Vivo option
from Calibration Utilities.

Smart Mouse Options

Includes parameters that are to be calculated and displayed for the
Smart Mouse (see Smart Mouse on page 48).

Guidelines

For HRM procedures only. Allows selection of anatomical
guidelines on the main display. The guidelines run horizontally and
are intended for visual purposes only.

Display Mode Options
Save Selected Data

Allows selection of different Main and Profile Display options (see

Display Mode Options Menu on page 19).

Allows saving of the pressure or impedance data visible on the main
display. The data can be saved as text and as ManoScan study
format (.mvs, mvsar, or.tls). (See Step 7: Saving the Study on
page 43.)

Display Mode Options Menu
This menu controls how studies are displayed.
Menu Item

Explanation

Applicable for...

Enable Pressure Traces on Enables Pressure Trace on Contour mode. HRM
Contour
Show Catheter in Profile

Displays the catheter in the Profile Panel.

all types of studies

Enable Impedance Traces Turns on Impedance Trace Mode.

HRM Impedance

Enable Impedance Trace
on Contour

Displays trace on Contour Mode.

HRM Impedance

Show HD in Profile

Displays HD information in Profile Panel.

Show Easy-to-read Values Displays the real-time channel values (in
large font) to the right of the main display.

ManoScan
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Saving and Loading User Preferences
You can save the settings of the current display. These settings can later be reloaded so that
the program displays the data in the current configuration.



Note
ManoScan has two default settings:
• Default: user-defined settings applied every time ManoScan is
started.
•

Factory Default: restores factory defaults.

Among the parameters that are remembered and reloaded are:
•
•
•
•
•
•
•

maximum and minimum range values
time base settings
current protocol
display modes
channels selected
channel mode (Free Selection or Landmark Reference)
channel position unit selection

To change default setting or to create a custom configuration (for example, settings
appropriate for pharyngeal research):
1.

Set the value of each of the controls in ManoScan as desired (for example, set the
values of Main Display pressure range as preferred).

2.

Select Setup > Save Settings.

3.

Select a group of settings (Main and Profile Display Options, Main and Profile
Display Range, and 3D Range and Visualization). You can select any combination
of these.

4.

Enter a name for the configuration and click Save.

To reload the settings, click Load Settings. ManoScan immediately applies the settings
and displays the Main Display accordingly. If the current configuration is saved as default,
(Default.cft), the program starts in this state the next time it is run. This allows you to
customize the start-up viewing configuration and have other viewing configurations for
specific needs.

The Display Environment
Before starting, familiarize yourself with the screens as they appear during a procedure.

ManoScan
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Real-time Data Display
Real-time pressures (and impedance, if available) are viewed on two different display
areas: the Main Display, which shows the pressure or pressure-impedance history, and the
Profile Display, which shows the current pressure or pressure-impedance distribution.
Esophageal

Anorectal

Main display in Contour mode, Pressure
Profile in Color Map mode

Main display in Contour mode, Pressure
Profile in Line Trace mode

Main display in Line Trace mode,
Pressure Profile in Line Trace mode

Main display in Line Trace mode,
Pressure Profile in Color Map mode

Figure 8. Pressure Display areas shown in various modes (esophageal
and anorectal programs)

Changing Display Modes (HRM)
ManoScan provides the capability of viewing data from all high-resolution sensor
channels simultaneously as a contour map in real-time (see the left side of Figure 9), or as
line tracings selectable for any location along the sensors (see the right side).

Figure 9. Main Display in Contour (left) and Line Trace (right) modes

To switch between modes, click Display Mode. While in Line Trace mode, you can select
the locations of line traces from the 36 available channels (12 or 8 channels for anorectal
manometry system) by manipulating the pointers in the Profile display.
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During viewing, Scroll/Review toggles between real-time viewing and a freeze-frame
view. (Data recording continues undisturbed, even when the display is in freeze-frame.)
If a pressure-impedance probe is used, you can display or hide impedance data on the
main display by toggling Show Z / Hide Z. The impedance data is superimposed and
synchronized in time with the pressure data. The impedance traces have the similar layout
as that of pressure traces and can be viewed by toggling Display Mode.

Figure 10. Contour plot of pressure impedance data displayed in Main
Display

If 3D type catheters are being used (ESO 3D or AR 3D), a 2D/3D button in the bottom left
corner of the screen toggles through different 3D visualization modes, allowing for
detailed real-time 3D visualization. The view cycles through configurations of the 3D
window.

Figure 11. 3D View window showing 3D visualizations available in
ManoScan

ManoScan
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Probe Setup and Selection: HRM
Installing a Probe
Probes must first be installed, which involves connecting the probe and entering the
appropriate serial number and key code (provided by Given Imaging). Enter this
information and click Install.

Figure 12. Entering a probe’s serial number and key code

Selecting a Probe
The HRM tab is displayed on the Select Source screen when an HRM module is
connected to the system. It lists the probes (installed previously) that can be used for
conducting an HRM study. For each probe, this information is displayed:
•
•
•
•

probe serial number
number of uses to date
service code (for customer support)
attention flag
to indicate that some recommendation or warning regarding
probe needs attention. The recommendation is displayed when the probe is
selected. Typical reasons for an attention flag are number of uses exceeds/or about
to exceed the maximum recommended probe usage, or In-Vivo compensation is
overdue.
To select a probe, highlight it and click Select.



!
ManoScan

Note
When an installed probe is selected from Select Source for the first
time, you are automatically navigated through catheter tuning and InVivo calibration. Once these tasks are performed, the probe is ready to
be used for procedures.
Caution
Make sure that the probe serial number (on the body of the probe)
matches the selected probe in the ManoScan software. If the probe is
changed between procedures, select the new probe (Setup > Select
Probe).

23

User Guide

Figure 13. Select probe



Note
If an impedance probe (that is, EAZ probe) is to be used for a pressureonly study (that is, as EAN probe), select the Use EAZ as EAN
checkbox. This means that no impedance data will be acquired for the
study.

Calibrating a Catheter
The catheter must be calibrated prior to each clinical procedure.
1.

Make sure that the system is turned on and running for at least five minutes before
calibration.

2.

For systems using both HRM and 3D type catheters in the same system setup, make
sure that the catheters not to be used for this procedure are not plugged into the
modules.

3.

Place the catheter in the calibration enclosure to the appropriate depth:
• 42–45 cm (16.5–17.5") for the normal esophageal catheter
• 52–55 cm (20.5–21.5") for the 3D esophageal catheter
• 15 cm (6") (to the balloon fill lumen) for the anorectal catheter
• for the AR 3D probe with the AR 3D ManoShield applied, insert into the AR 3D
pressure calibration chamber up to the handle of the probe



ManoScan

Note
If the system has been upgraded to the 3D esophageal catheter, make
sure to replace the calibration tube to allow for the extra length of the
3D catheter. The replacement tube is provided with the purchase of the
upgrade.
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Make sure that the probe is at the correct depth before sealing.

!

Warning
To prevent catheter damage, do not tighten the seal knob directly over a
sensor element!

4.

Tighten the seal knob (see Figure 3 on page 13) finger tight. Make sure that the
probe is properly positioned and click Calibration (in the top panel).

5.

If both the regular and small diameter catheters are to be pressure-calibrated on the
same system, use the removable top seal knob, which has the step extension, on the
pressure calibration chamber. Make sure that the intended use catheter is in the
appropriate chamber and that the provided plug is inserted into the catheter insertion
opening of the unoccupied chamber to ensure proper pressure calibration.
step extension

Figure 14. Step extension on removable seal knob

6.

If 3D anorectal probes are being used with any other type of catheter in the same
system setup, make sure that the correct seal grommet is being used with the correct
calibration chamber. This is because the calibration chamber for the 3D anorectal
probe differs from the calibration chamber for all other catheters.

!

Caution
Do not place a catheter or probe into the not-in-use pressure calibration
chamber.

7.

From the ManoScan toolbar, click Calibration to open the Calibration screen.
The pump turns on and the pressure display on the Calibration screen shows the
output from the reference sensors, which independently measure the pressure in the
chamber. Once the maximum calibration pressure has been reached, the pump turns
off and the chamber returns to atmospheric pressure as indicated by the sound of
leaking air.

8.

To stop the calibration process before completion:
• Click Abort. Calibration stops but the Calibration screen remains open.
• Click Cancel. Calibration stops and the Calibration screen is closed. The
calibration status of the probe (Calibrated or Uncalibrated) appears in the status
display near the top of the screen.

9.

When calibration is finished (about 10 seconds), click OK on the Calibration screen.

ManoScan
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Calibration Utilities
These utilities enable configuring the thermal, electrical, or functional characteristics of a
probe.

Figure 15. Calibration utilities

Tune System
This utility identifies characteristics of a particular catheter so that its performance may be
optimized (for example, if the pressure calibration is not successful or if instructed to do so
by Given Imaging personnel). Place the catheter in the calibration tube in the same way as
when performing a normal pressure calibration. Select Tune System. The process takes
approximately 90 seconds, during which you can see some changes in the real-time display.
Proceed to calibration immediately after this tuning process. Once tuning is performed, the
system keeps track of the proper tuning and other parameters for each catheter.
Calibrate In-Vivo
This utility calibrates the probe relative to the elevated temperatures and aqueous
environment of the body. This compensation is useful for accurate viewing of real-time
data when the catheter is in the body. The pressure data should also be compensated for
offset due to elevated body temperature later during analysis in ManoView software
(using the ManoView Thermal Compensation feature).



Note
Before performing in-vivo calibration, the probe must first be pressure
calibrated (see Step 2: Calibrating a Probe on page 38). The In-Vivo
button is disabled until the probe is pressure calibrated.

To perform in-vivo calibration:
1. Prepare a shallow basin of water at 96–100o F (36–38o C) by mixing hot and cold
water and using a body thermometer*. Mix thoroughly for thermal uniformity.
(*The legal manufacturer of this item is: A&D Medical, San Jose, CA, USA)
2. Make sure that the catheter is in a pressure-free state (for example, lying on a flat
surface) both outside and inside the basin at the appropriate times.
3. Follow the on-screen instructions to complete this process.
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4. Perform in-vivo calibration at least once a week.
Note
• The probe must be at room temperature at the beginning of the
procedure. If the probe has been handled or immersed in warm
water, leave it at room-ambient temperature for at least 5 minutes
before performing in-vivo calibration.



•

The probe should have no applied pressure prior to immersion and
after immersion. Make sure that the probe is lying flat with no kinks
or external objects touching.

•

Make sure that water is well mixed for thermal uniformity.

•

Do not immerse probe until instructed to do so. This will lead to
erroneous calibration.

•

Do not use more than 4 cm (1.5") water depth to avoid water
pressure-induced errors.

•

Do not apply protective ManoShield sheaths before or during in-vivo
calibration, with the exception of the AR 3D catheter, which has the
sheath applied during in-vivo calibration.

•

For the 3D esophageal catheter, after inserting the catheter in the
warm water, allow the catheter to stabilize for approximately one
minute before clicking Next.

Applying In-Vivo Compensation
In-vivo compensation is automatically applied by the Guide when the recording is started.
Mask/Interpolate
This utility allows the system to ignore or mask the data of one or more pressure and/or
impedance sensors. The adjacent sensor data is used to linearly interpolate across the
masked sensor; the masked sensor’s data does not appear on screen or in the stored file.
This creates a virtual channel and the system otherwise behaves as normal. This utility is
useful to eliminate data from a non-functioning sensor in one or more non-essential
locations. The location of the masked pressure channel is indicated by this symbol
in
the pressure profile display. The location of the masked impedance channel is indicated by
the same symbol in purple.



ManoScan

Note
There are guidelines that define which sensors can be masked for a
particular HRM probe type. When a sensor masking operation is not
recommended, a warning appears in the Guide Wizard. For details
about the clinical rationale behind these guidelines, contact your Given
Imaging representative.
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Uninstalling a Probe
To remove a probe from the list, highlight it and click Uninstall. A probe should not
normally be uninstalled during its lifetime.



Note
Uninstalling a probe removes its installation parameters from the
ManoScan system. The probe can only be reinstalled after receiving a
new key code from Given Imaging.

ManoScan: Additional Information
This section provides additional information about the various display modes for the
different procedure programs in ManoScan.
Pressure Profile Display Modes – Esophageal Program (HRM)
The pressure profile display normally shows the current real-time pressure values, which
can be viewed as a smooth curve or as a color map. Click Mode (below the pressure
profile) to toggle between the two. Click Anatomy to display an approximate anatomical
depiction (based on the positions of the landmark indicators) after the UES and LES
markers have been adjusted.
The various possible configurations of the pressure profile are shown in Figure 16 and
Figure 17. The position indicators for the Upper Esophageal Sphincter (UES), Lower
Esophageal Sphincter (LES), and Pressure Inversion Point (PIP), and upper and lower
margins of the LES can be adjusted by dragging their markers on the pressure profile
display. This is most useful when the Main Display is in contour mode where horizontal
lines facilitate localization of the anatomical landmarks.



ManoScan

Note
The positions of the LES, UES, and PIP markers are not saved with the
study. If they are to be used for analysis, adjust the pointers in the
ManoView analysis software.
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Mode: Line Trace
Anatomy: Off

Mode: Color Map
Anatomy: Off

Mode: Line Trace
Anatomy: On

Mode: Color Map
Anatomy: On

Figure 16. Available pressure profile displays (esophageal program)

Pressure Profile Display Modes – Anorectal Program (HRM)
For the anorectal program, the same options of data display are available as for the
esophageal program. Toward the top of the display are shown one (small probe) or two
(for regular probe) channels of the sensors near the tip of the probe, which may be used to
measure balloon or rectal pressure, as appropriate. Anatomical markers are available to
adjust the positions of the upper and lower boundaries of the anal sphincter. When the
anatomy is displayed, these adjust the location of the depiction of the anal canal.



ManoScan

Note
The positions of the anatomical markers are not saved with the study. If
they are to be used for analysis, adjust the pointers in the ManoView
analysis software.
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Mode: Line Trace
Anatomy: Off

Mode: Color Mode
Anatomy: Off

Mode: Line Trace
Anatomy: On

Mode: Color Mode
Anatomy: On

Figure 17. Available pressure profile displays (anorectal program)
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Pressure-Impedance Profile Display – Esophageal Program (HRM)
In addition to the profile features, an impedance trace and a bolus depiction of impedance
data is also displayed in this mode. An example of peristaltic wave contraction and bolus
movement as viewed in pressure-impedance profile view follows:

Figure 18. Bolus movement in a normal swallow as viewed in pressureimpedance profile display, with and without anatomy displayed

Display Pressure Reference (HRM)
The display pressure reference is available for the HRM procedures and is set using the
control at the lower left of left panel. The value is set according to the current 30-second
average of the desired reference (atmospheric or gastric/rectal, depending on the
procedure) at the time the control box is closed. This reference is for display purposes only
and does not affect the recorded data. The Gastric/Rectal position pointers on the profile
may be moved vertically to select the position at which the gastric/rectal reference
pressures are taken. The baseline pressures are calculated from a 30-second average of the
data relative to the current time.
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Scale Controls (HRM)
The scales of the various displays can be changed with these controls. Use the slider
control to set the new scale value and then click outside of the slider to hide it (Figure 19).
Click All for the Line Trace scale control to scale all traces accordingly.
Control

Location

Line Trace Limits

left of each channel

Time Base

lower left of main display

Pressure/Impedance Profile Limits

below profile display

Contour Limits

below color map

Figure 19. Scale Adjustment Slider (Line Trace Limits)

Trace Mode Channel Selection (HRM)
Trace Channel Selection may be done by either manipulating the markers on the pressure
profile plot, or selecting the channels on the Trace Display Channel Control screen (by
clicking Channels).
•

Esophageal Program: Click Channels to display the Trace Display Channel
Control screen. You can then select channels to be displayed in either Free Selection
mode or the Landmark Reference mode by clicking the corresponding button. To set
the way the channels are displayed in either mode, select that mode and then click
Setup. For Free Selection setup, all available sensor channels appear; select which
ones you wish to be displayed. For Landmark Reference mode (esophageal program
only), you may select multiple channels at specified distances from the LES and
UES.

•

Anorectal Program: Click Channels to set the way the trace channels are
displayed. Select which ones you wish to be displayed, including the balloon/rectal
pressure sensor channels, and these will be displayed in the pressure profile.

Manipulating Channels via the Pressure Profile (HRM)
The channels for trace display may be selected by graphically manipulating the channel
pointers in the pressure profile display. When the main display is in contour mode, vertical
movement of a channel in the pressure profile causes a horizontal guideline to appear in
the main display to assist in positioning the channel location relative to the contour data.
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In Free Selection mode, move the chevron shaped pointers up and down to select the
position of a given channel.
In Landmark Reference mode (esophageal program only), the channels are held in fixed
position relative to the LES and UES as set in the Channels control. When the LES or UES
pointers are moved in the pressure profile, the channels move with them, thus the channels
at fixed distance from the anatomical landmarks are easily found by positioning the
landmark pointers with the main display in contour mode.
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Chapter 5

HRM Procedures

Preparing for the Procedure
A probe must be installed (that is, connected and configured) with the software before it
can be used for studies.
1.

Before a procedure, clean the catheter according to the approved high-level
disinfection process.

2.

If using a ManoShield Disposable Sheath: install and remove per instructions
provided with each type of sheath. Use the squeegee to remove all air between the
catheter and the sheath to avoid excessively high pressures in the study at the distal
portion of the catheter.

!

Caution
Due to sheath length limitations, the ManoShield Disposable Sheath is
not recommended for use in proximal gut manometry (gastric
duodenal).

Start the ManoScan software by running ManoScan Acquisition. From the Select
Source screen, select the currently connected catheter (see Step 2: Calibrating a
Probe on page 38).

3.

Types of Procedures
Recommendations for HRM procedures are described in this section.
Esophageal Motility
Data collection may be via the standard esophageal manometry Guide or the Free Run
Guide. Perform trans-nasal intubation according to a procedure approved by the
responsible physician. Trans-oral intubation is not recommended. Position the patient:
•

standard patient positioning during catheter trans-nasal intubation: place the patient
in a sitting position in close proximity to the system, within the length of the catheter
being used and connected to the system.

•

alternative patient positioning, such as standing (may be necessary to facilitate
catheter intubation): position yourself between the system and the patient to
adequately intubate the patient. Make sure that the catheter remains connected to the
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system to visually aid intubation by using the pressures presented in the acquisition
software. For the study, the patient may remain in a seated position, placed in a
supine (15–30 degree angle) position or lying down in a flat position, according to
the procedure specified by the responsible physician.
Impedance data collection can be disabled prior to the procedure. If impedance data
collection is enabled, impedance data visual presentation can be turned off and on during
esophageal motility studies.
For 3D Esophageal studies, perform them in the same way as Esophageal Motility studies,
but be sure to locate the LES immediately in the center of the 3D section of the catheter, as
shown below:

Figure 20. Locating the LES in an ESO 3D study

Anorectal Manometry Using an Anorectal Catheter
Data collection may be via the Standard Anorectal Manometry protocol. Perform probe
introduction and positioning according to a procedure approved by the responsible
physician. Position the patient for catheter insertion:
•

standard patient positioning: place the patient on a flat surface such as a bed, in a left
lateral position with knees and hip flexed in close proximity to the system, within
the length of the catheter being used and connected to the system.

•

alternative patient positioning, such as squatting (may be necessary to facilitate
catheter insertion): position yourself between the system and the patient to
adequately insert the catheter in the patient. Make sure that the catheter remains
connected to the system to visually aid insertion by using the pressures presented in
the acquisition software.

For the study, the patient may remain on the flat surface, in a left lateral position with
knees and hip flexed according to the procedure specified by the responsible physician.
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Insert the probe to an appropriate depth so that the anal sphincter is positioned in the
center of the contiguous sensor section of the array. If using the AR 3D probe, keep the
Posterior alignment bump on the handle at the same reference angle to the patient
throughout the procedure. Do not allow the catheter to excessively bend or move during
this procedure. To prevent catheter damage, balloon inflation may only be performed with
air and not liquid. Given Imaging does not recommend instructed patient expulsion of the
HRM and 3D catheter probes.

Using the Guide Wizard
The Guide provides a display of instructions and automatically opens relevant screens
within the program. It also marks specific time periods, called measurement frames, in the
record during which relevant data is being collected. Measurement frames are necessary
for subsequent automatic data analysis and report generation. They are not provided
during manual data collection, but they may be added later using the ManoView analysis
program.

Figure 21. Sample of Guide Wizard instructions

The Guide walks you through the following workflow:
•

Step 1: Entering patient information.

•

Step 2: Selecting and calibrating the probe.

•

Step 3: Inserting the catheter and any other setup instructions.

•

Step 4: Initiating the recording.

•

Step 5: Performing the actual procedure.

•

Step 6: Annotating the study.

•

Step 7: Ending recording and saving the study.

Click the blue-bordered Start button (upper right of the screen) and follow the on-screen
instructions. Use the GoTo button to navigate backward and forward through the Guide.
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Note
The workflow is the same across all Guides and procedures, apart
from performing the actual procedure. Procedure steps depend on the
selected Guide.
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The following Guides are available for HRM procedures:
Procedure

Guide Name

Description

High-resolution Esophageal
Manometry

HRM-ESO

Standard Esophageal HRM procedure Guide

Free Run

Does not prompt for procedure-specific
measurement activity.

HRM-AR

Standard Anorectal HRM procedure Guide

Free Run

Does not prompt for procedure-specific
measurement activity.

High-resolution Anorectal
Manometry

Step 1: Entering Patient Information
Enter patient information as prompted by the Guide wizard. Alternatively, click File >
New to open the Patient Information screen. This screen contains mandatory fields that
must be completed before you can proceed with the study.

on-screen
keyboard button

Figure 22. Patient Information screen

The keyboard button opens an on-screen keyboard so that information may be entered via
the touch-screen display. Clicking the keyboard button closes the keyboard. The Patient
Information screen includes pull-down lists that automatically save information such as
Physician Name and Test Operator. To delete an item from the list, select the item and
click the delete icon

next to the list.

Saving and importing patient information: You can enter patient information in
advance of the procedure, and then retrieve it when needed. To do so, enter the patient data
and click Save for Import. To retrieve the patient data, click Import. The Patient Manager
screen appears, listing all patients saved for import. The Patient Manager screen looks the
ManoScan
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same as the Study Manager screen (see Reviewing the Study with the Study Manager on
page 44); however, the Study Manager displays the list of previously conducted studies
saved on the PC and the Patient Manager displays the list of patients scheduled for a study.



Note
Importing of patient data can also be linked with your HIS. When the
HIS is properly connected with the ManoScan software (see
Connecting to Your HIS (Hospital Information System) on page 14),
the software can load patient information for patients scheduled for the
procedure.

Step 2: Calibrating a Probe
Probes must first be installed and calibrated before they can be used. See Probe Setup and
Selection: HRM on page 23 for details.

Step 3: Inserting the Catheter
Technique and Catheter Precautions
Follow these guidelines when handling the catheter probe during clinical data collection:
•

Zero the channels. The catheter pressure channels may be zeroed one last time
immediately before patient intubation. To do so, click Zero Channels in the
Calibrate screen, while the catheter is in a pressure-neutral state such as hanging
freely in the air.

•

Handle the probe with the lightest possible pressure. During patient intubation,
always monitor the real-time display to make sure that the pressures applied by the
operator is kept below 50 mmHg and never exceeds 100 mmHg (the actual pressures
at the sensor can be considerably higher since they involve much higher localized
values than those indicated). This helps assure more stable readings during the
study.

•

Make sure that the probe or the catheter does not become doubled back on itself
while in the body. This condition appears as a symmetric signature in the pressure
profile and Main Display. If this occurs, withdraw the probe immediately to the
point where the condition no longer exists. Prolonged periods in the doubled-back
state can lead to premature failure of the probe (see Probe and Catheter Guidelines
on page 1).
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Figure 23. Pressure signature of doubled-back catheter condition

Step 4: Initiating the Recording
Follow the Guide wizard instructions as they appear on the screen. The software
automatically applies in-vivo compensation when recording begins.

Step 5: Performing the Procedure
Standard Esophageal HRM Procedure
The Standard Esophageal Motility procedure follows this workflow:
1.

Start. Click the blue bordered Start button and follow the on-screen instructions to
enter patient information, perform calibration, intubate patient, and record catheter
position.

2.

Landmark ID and Sphincter Pressure Measurement Frame. After patient
acclimation, click Start to begin the measurement frame. The measurement frame
closes automatically after the specified duration (typically 20–30 seconds).

3.

Swallow Frames. Click Start to begin the first of 10 swallow measurements.
During this period, a measurement frame is drawn for each swallow event. Provide
the amount recommended by the physician (typically 5–10 ml) of room temperature
water or other liquid such as saline solution for ESO Z studies or food and ask the
patient to swallow shortly after the start of the measurement frame. Click End after
the swallow is complete or allow the frame to auto-close after the specified duration
(typically 20–30 seconds).
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4.

End. After 10 swallows, additional swallows may be completed as described above
or you may click Finish to end the swallow sequence. After finishing, click End to
clear the display, save the record, and allow for a new patient.

Standard Anorectal HRM Procedure
The Standard Anorectal HRM procedure follows this workflow:
1.

Start. Click the blue bordered Start button and follow the on-screen instructions to
Enter Patient Information, perform Calibration, and intubate patient.

2.

Resting Pressure Frames. After patient acclimation, click Start to begin the
measurement frame. The measurement frame closes automatically after the
specified duration (typically 20–30 seconds).

3.

Squeeze Frames. Click Start to begin the squeeze measurement. The patient is then
normally instructed to squeeze. Click End after the maneuver is complete, or allow
the frame to auto-close after the specified duration (typically 20–30 seconds).
Additional squeeze measurements may be made by clicking Start, or move to the
next measurement type by clicking Finish.

4.

Push (Bear Down) Frames. Click Start to begin the push (bear down)
measurement. The patient is normally instructed to push or bear down as in
defecation. Click End after the maneuver is complete, or allow the frame to autoclose after the specified duration (typically 20–30 seconds). Additional push (bear
down) measurements may be made by clicking Start, or move to the next
measurement type by clicking Finish.

5.

Balloon Inflation Frames. You are prompted to indicate the next fill volume (use
the balloon volume controls on the lower right of the display screen and click Set).
Click Start to begin the balloon inflation measurement and inflate the balloon to the
desired volume using air only (do not fill with liquids). Click Sensation, Urge, or
Discomfort as per patient response to the inflation. Click End after the maneuver is
complete or allow the frame to auto-close after the specified duration (typically 20–
30 seconds). To make additional measurements by repeating the process above for
setting the fill volume, click Start and inflate the balloon. To move to the next
measurement type, click Finish.

6.

Optional Maneuvers. This function allows you to record maneuvers or
measurements in addition to those listed above; for example, party balloon inflation.
Use the << Other button to document the optional maneuvers. To skip this step and
conclude data collection, click End.

7.

End. Remove the probe without touching the sensors. Click End to terminate data
recording, clear the display, save the recorded study and allow for a new patient.
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Free Run Guide
This Guide allows you to perform general testing according to a physician-approved
procedure. The Guide supports the entry of patient data, calibration, recording, and
subsequent closing/saving of the data file. However, it does not prompt for specific
measurement activities. The Free Run instructions are essentially the same for Esophageal
and Anorectal Manometry Guides.
Removing the Catheter
Provide a pressure-neutral reading immediately after extubation. Allow at least 1 second
for the probe to be in a pressure-free state (hold it in air by the ruled section without
touching the sensor section). This pressure-neutral condition, at or near body temperature,
allows for more precise thermal compensation during subsequent data analysis.

Step 6: Annotating the Study
There are several kinds of default annotations (located on the right panel) that can be
inserted on the main display and recorded to the study. Different procedures support
different annotations. Annotation shortcuts are available on the right panel and can be
customized.
Catheter Position
When conducting a study, make sure to always update the catheter position with the
correct distance from nares (nostril entrance) or anal orifice, as marked on the ruled
section of the catheter probe. The distal-most sensor is used as reference for the
catheter position. This annotation is provided for the following procedures:
esophageal, conventional anorectal, and antroduodenal manometry.

Figure 24. Catheter position

Balloon Fill Annotation
To annotate the record with the balloon volume in anorectal studies, select the desired
volume using the up/down arrows in the control and click Set.

Figure 25. Setting balloon volume
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Default Procedure-Specific Annotations
Procedure

Annotation

Esophageal Manometry

Wet Swallow
Dry Swallow
Cough/Gag

Anorectal Manometry

Sensation
Urge
Discomfort

Antroduodenal and Colonic
Manometry

Meal

Sphincter of Oddi Manometry

Common Bile Duct

Med
Pancreatic Bile
Sphincter of Oddi
Med

Audio Annotation
If a microphone is connected to the computer, audio annotations can be used to
record any study-specific instruction or observation. These annotations, like all other
annotations, are saved with the study file; the audio recording can be replayed during
review mode. This annotation is available with all procedure types.
Custom Annotations
You can create any custom annotation. Click the Other button to open the Add
Annotation/Event screen. Enter any text to describe events (see the following
figure). Once an event is entered, it appears in the list and can be reused. Any
predefined annotation events can then be used in the Event tab (see Default
Procedure-Specific Annotations on page 42).
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You can create a shortcut for an annotation. In this example, a custom button (Belch)
was added on the right panel. When clicked, it inserts the text “Strong Belching” on
the main display.

Figure 26. Adding custom annotations

Step 7: Saving the Study
At the end of the procedure steps, the Guide prompts you to save the study. Studies are
saved in the Study Repository, which is defined in Folders > Study Repository.
The file extensions for esophageal and anorectal HRM studies are *.mvs or *.mvsar,
respectively. The folder location of the *.mvs, *.mvsar, and files must be the same to
support video review.



ManoScan

Note
If you exit without saving the study, the study file is auto-saved to the
Temp folder (inside the ManoScan installation folder). The auto-saved
study is named based on its date and time.
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Chapter 6

After the Procedure

Cleaning Catheters After Use
After the procedure is finished the catheter should be disconnected, cleaned, and highlevel disinfected.

HRM Catheters
If a disposable sheath is used, dispose of it according to appropriate biological waste
protocols. Be sure to turn off data recording after the procedure has ended. To shut down
the software, select File > Exit. If the data was not already saved, the program prompts you
to save the file before exiting.

Reviewing the Study with the Study Manager
The saved study is typically reviewed in the ManoView analysis software, which provides
specialized tools and features for analysis and report creation. The study can be also be
reviewed in ManoScan software (through the Study Manager screen), but you cannot
modify the original study file despite being in the data acquisition application. This
protects the authenticity of the original data saved during acquisition.
The Study Manager is the most efficient way to browse all existing studies. The Study
Manager scans the Study Repository folder (as defined in Setup > Study Repository),
where the studies are saved, and populates the study information in form of a table. This
scan operation is performed every time the Study Manager is opened, so that the list is upto-date. If a file stored at some other folder location is browsed (Open File button), the
corresponding folder is also scanned and all of its studies are added to Study Manager list;
however, such folders are not scanned regularly.
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The Study Manager dialog is accessible from either Select Source > Review or File >
Review Patient File. The various controls on the Study Manager screen are:
Control

Explanation

Open File

Opens the Open File screen to select a file not saved in the
Study Repository. Once opened, all files at the location are
also added to Study Manager list.

Advanced

Displays additional controls for searching and filtering
studies in the list. Also allows customization of Study
Manager fields (see Advanced on page 45).

Delete

Deletes a study file from Study Manager list. The file is not
deleted from the PC.

Refresh

Refreshes the Study Manager to remove studies from the list
that are no longer available in their original locations.

OK

Opens the selected study.

Cancel

Closes the Study Manager.

Figure 27. Study Manager main screen

Advanced
The additional features available by clicking Advanced are shown in the following figure.
You may specify filter criterion for up to three fields to filter the Study Manager list. This
lets you see the subset of files appropriate to your search. For example, specifying
Gender: Male as the filtering criterion results in studies conducted for male patients only.
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Figure 28. Filtered list

The field selection box on the right allows selection of columns you want displayed in the
Study Manager. The order in the field selection box determines the order of the columns.
For example, the patient ID will be shown as the left-most column. To reorder columns,
uncheck all the fields in the field selection box, and then check them in the order of
preference.

Other Tools
3D Study-specific Controls
Access the 2D/3D window by clicking 2D/3D on the left panel. The following figure is
shown for anorectal 3D procedure; however, the functionality is applicable for esophageal
3D procedure (conducted with an EAY catheter) as well.
There are three different plots in the 2D/3D window that utilize the unique functionality of
the 3D catheters. These are 2D HRM plot, 3D HRM plot, and cross-section plot. The
2D/3D button toggles different views consisting of these plots.
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Plots and Views
Cross-section plot: Displays the cross-section of the pressure pattern at the location
specified from Setup > Channels.
2D HRM plot: Displays a cross section on the left and a 2D map of the 3D sensor plot.
3D HRM plot: Displays a 3D cylindrical view of the sensors. Rotate the cylinder by
clicking and dragging.

Figure 29. Plots and views

2D/3D View Buttons
Several controls are available to alter the display of the 2D and 3D windows.

Deflection /
Range

Home
Zoom

View Mode

Capture

Anatomy Toggle

Figure 30. 2D and 3D window controls

Anatomy Toggle: Turns the anatomy drawing on and off in 3D HRM and 2D/3D HRM
views.
Deflection/Range: Changes the deflection/ranges of the cross-section view in 2D HRM
and 2D/3D HRM views.
View Mode: Cycles between Wide Cylinder, Narrow Cylinder, and Vector Volume views.
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Capture: Takes a screen shot of the current view of the 3D HRM window for printing or
saving in the study report.
Home: Places the 3D window back in its original place in the lower left-hand corner of the
contour screen in the event that it was moved or resized.
Zoom: Increases and decreases the size of the 3D window.
Rotation: Translates the 3D cylinder view around its desired axis. Clicking these buttons
rotates clockwise. To rotate counter-clockwise, hold Shift, then click the rotation buttons
.
Smart Mouse
The Smart Mouse tool provides analytical information by left-clicking the mouse. The
analytical data is redisplayed next to the cursor. The parameters are calculated within the
Region of Interest (ROI) defined by Begin Point (BP) and End Point (EP). Turn the Smart
Mouse on by clicking Smart Mouse on the bottom panel. The Smart Mouse works in the
following different modes:
•

Hover on contour mode: Moving the cursor over the main display updates and
displays the analysis parameter values in real time.

•

Drag on contour mode: Clicking-and-dragging across any two points on the
contour mode draws a rectangular ROI for which the analysis information is
provided.

•

Drag on line trace mode: Clicking-and-dragging across any two points on same
channel or different channel draws the ROI for which the analysis information is
provided. If the two points are on different channels, only the difference information
is calculated and displayed.

Figure 31. ROI displayed in contour mode (left) and trace mode (right)
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You can draw multiple Smart Mouse regions on the screen by pinning existing regions of
interest:
•

Click the pin icon that appears when the cursor is on the top right corner of the ROI,
or

•

Hold the Ctrl key down while drawing the ROI (click-and-drag).

A description of the Smart Mouse options follows:
Group

Parameter

Difference Info

Difference

Distance between EP and BP

Velocity

Distance / duration

Data Difference

Data value difference between EP and BP

Min / Mean / Max

Amplitude / Basal

Description

Duration

Time difference between EP and BP

Max

Maximum data value in ROI

Mean

Mean data value in ROI

Min

Minimum data value in ROI

Amplitude

Average of difference of local maxima (‘peaks’) and
local minima (‘valleys’) in ROI

Basal

Average value of local minima (‘valleys’) in ROI

Frequency

Frequency

Number of local maxima per minute within ROI

Motility Index

Motility Index

Natural logarithm of the positive integral of the tracing
within the ROI divided by the time (in minutes).

Save Selected Data
In addition to the normal saving of the recorded data, a selected portion may be saved for
subsequent review and analysis. This may be accomplished both during initial data
acquisition and subsequent review of saved patient files. The time duration for the desired
data is selected by using Smart Mouse in the Main Display while in Contour mode. If no
data is selected, the data displayed on the main screen is saved. You may then choose Save
Selected from the Tools menu and select from one of the following available data file
formats:
•

Text file: The range of data is saved as a tab-delimited text table where the rows are

the data records for each sample time, the first column contains the sample times,
and the subsequent columns contain the pressure values (mmHg) for each sensor in
the range selected from distal to proximal and pressure values of the two reference
sensors. If the impedance data is also recorded, it is saved after the last pressure data
column. The files are saved with a .txt extension.
•

Patient examination file: The data for the time duration of the diagonal drag area

are saved in a format that may be subsequently viewed in the ManoView software
(either data acquisition or analysis). The files are saved in the applicable program
with .mvs, .mvsar, and .tls extensions.
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Chapter 7

Maintenance and
Troubleshooting

Maintenance
No scheduled maintenance is required for the ManoScan system.

!

Warning
The modules and catheters of the ManoScan system do not include
end user serviceable components and may pose a hazard during any
attempts to troubleshoot or repair.
ManoScan system shall only be serviced by Given Imaging trained
service personnel.
No modification of this system or its components is allowed.

The ManoScan system, excluding the high-resolution catheters, is warranted to be free
from defects in material and workmanship under normal use for 2 years from the date of
shipment.
The high resolution manometry catheter probes are limited use devices warranted to be
free from defects in material and workmanship under normal use for 1 year or 100 uses,
whichever comes first, from the date of initial shipment.

Part Replacement
The seal grommets, O-rings, or gaskets of the calibration chambers may be subject to wear
after prolonged use.
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To help reduce wear on these parts, leave the calibration chamber
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50

User Guide

Replacement parts are provided with the system and are available from your Given
Imaging representative.
Part Number

Description

1283

Seal, Probe, MVS (ESO \ AR)

1284

Seal, Cal, Tube, MVS (ESO \ AR \ AR 3D)

112330

Probe Gasket Cal Rigid AR (AR 3D)

Figure 32. Replaceable seals, o-rings, and gaskets
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Maximum Study Duration
A study session can only be conducted for maximum study duration which varies from
probe to probe. The higher the number of pressure sensors, the less the study duration is.
The duration depends on computer system specification. Once the maximum duration is
exceeded, software starts overwriting the data acquired at the beginning of the study.
Probe

Maximum Study Duration

HRM Probes
Anorectal 3D (AAD)

1 hour

Esophageal HRM (EAN, EPS, EAS,
EAZ)

5 hours

Esophageal 3D hybrid probe (EAY)

1 hour

Connectivity
User Accounts
•

Windows User Accounts: The ManoScan computer ships with a default
administrative User Account ManoScan. If separate User Accounts are desired, they
may be created (see Read/Write capability).

•

Read/Write capability: If User Accounts are created and denied administrative
privileges, ensure that each User Account has FULL READ/WRITE ACCESS to
the folder where the software resides, C:\Program Files\SSI. The ManoScan and
ManoView software requires read/write capabilities to this folder to function
properly.

Data Backup and Preventative Maintenance
•

Patient Files & Custom Software Configurations: Given Imaging recommends
that each facility back up patient data and custom software configurations on a
regular basis to a network archive drive and/or external media such as CD, ZIP
drive, tape, etc. The entire SSI folder (default C:\Program Files\SSI) can be
archived, as it contains all patient files, custom configurations, and program
executables in its lower folder hierarchies.

•

Disk Cleanup (Once a month): This utility looks for old temporary files that can
be removed and are taking up space. (Start > All Programs > Accessories >
System Tools > Disk Cleanup).

•

Disk Defragmenter (Once a month): This utility reorganizes the files on the hard
drive in a more efficient way, so accessing them is quicker. (Start > All Programs >
Accessories > System Tools > Disk Defragmenter).
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Third-Party Software
•

Virus Scan Software: If antivirus software is required, it may be installed to the
ManoScan computer without voiding the Given Imaging equipment warranty.
However, this software must be procured and maintained by each facility. Given
Imaging claims no responsibility for these software installations.

•

Scan Times: If antivirus software is installed, make sure that its updates and scans
DO NOT occur during ManoScan procedures.

•

Other Third-Party Software: Some third-party software programs may void the
equipment warranty. Consult Given Imaging before installing third-party software.

Intranet Connectivity
•

Intranet Connectivity: The ManoScan PC does not need intranet connectivity to
perform procedures and analyze data properly. If desired, the computer may be
connected to an intranet without voiding the Given Imaging equipment warranty.

•

Saving Patient Data to Network Drives: If required, patient data may be saved to
network drives. However, ManoScan software still reads and writes data to the local
machine during report generation.

Internet Connectivity
•

Internet Connectivity: The ManoScan PC does not need Internet connectivity to
perform procedures and analyze data properly. If necessary, the computer may be
connected to the Internet without voiding the Given Imaging equipment warranty.

•

Website Restrictions: If Internet connectivity is permitted only to connect to
certain websites, make sure the following websites are viewable:
• Given Imaging website: www.givenimaging.com
• Remote Assistance tool (optional; for example, www.logmein123.com)

Remote Assistance
•

Remote Assistance: LogMeIn Rescue is the web-based remote assistance tool used
by Given Imaging to aid in troubleshooting and technical support. It is not required
to perform procedures and analyze data properly.

•

HIPAA Compliance: LogMeIn Rescue satisfies all requirements of HIPAA. The
document Meeting HIPAA Compliance Rules with LogMeIn Rescue is available
upon request.

•

VPN client software: Facility-specific VPNs are not supported by Given Imaging
for troubleshooting or technical support remote assistance.
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Troubleshooting
ManoScan Problems
Calibration Errors
During the calibration process, the software checks for the following error conditions. If
any are found, an appropriate error message is displayed with the Restart Calibration
button.
Error Message

Error Condition

Calibration error. Check that catheter is
properly sealed in calibration chamber and
that all hoses are secure; then restart
calibration.

The chamber does not reach 300 mmHg after 30
seconds, based on reference sensor readings.

Calibration error. Check that the pump is
off, the bleed port is clear, all hoses are
straight, and then restart calibration.

The chamber does not depressurize to within 2
mmHg of the initial reference sensor value within
30 seconds after the pump is stopped.

Calibration Error - reference sensor. Restart Difference between the two reference sensor
Calibration. If error persists consult the
readings at zero nominal pressure is greater
manufacturer.
than 2 mmHg or more than 3%, whichever is
greater.
Calibration Error - probe element baseline. Baseline non-repeatability is > 2 mmHg (initial
Restart Calibration. If error persists Consult and final ambient pressures).
Factory.
Calibration Error - probe element cal curve. Error between reading and cal curve is > 2
Restart Calibration. If error persists Consult mmHg or > 5% of reading, whichever is greater.
Factory.

Protocol (Study) Flow Logic
The study always starts at the beginning. Therefore, if the initial steps in a procedure such
as entering Patient Information and Probe Calibration are performed manually, the study
may be out of sync with the actual state of the clinical procedure. In this case, use the
Go To>> button to move to the correct step in the study.
Loss of Power
If there is a loss of electrical power, first make sure that the line source (for example, wall
socket) is providing proper voltage. If proper power is confirmed, contact your Given
Imaging representative.
HRM Catheter Calibration Error
1.

Verify that the pressure data acquisition A120 module is powered on and that the
USB is connected and communicating.

2.

Verify that the catheter serial number selected in the software matches the catheter
serial number connected to the module.
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3.

Make sure that the intended use catheter is the only catheter connected. Do not have
a catheter connected to the A120 and the A300 modules at the same time.

4.

Verify that catheter is correctly inserted and completely sealed in the pressure
calibration chamber (make sure no sensors are pinched in pressure calibration
chamber gasket):
a. esophageal catheter insertion: to the CAL mark on the ruled tubing.
b. anorectal catheter insertion: balloon fill tube is almost touching the top of the
chamber twist knob.

5.

If a ManoShield is used, verify that it is applied correctly and has been applied for
less than 20 minutes. Refer to the ManoShield ESO instruction card.
If a properly-applied ManoShield may be applying constrictive pressure on the
sensors identified in the calibration error message, try again to pressure-calibrate the
catheter by pressing Start in the Calibration window.

6.

If different sensors fail each time, tune catheter (Calibration Utilities > Tune
System), and try again. Make sure that during tuning, the catheter is hanging in the
calibration chamber with no pressure exerted on its sensors.

7.

If the inability to successfully pressure calibrate the catheter persists, contact your
Given Imaging representative.
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Pressure Failure
If pressure stops building in the calibration chamber (does not reach 300 mmHg) and the
pump continues to run:
1.

Make sure that the calibration chamber catheter seal knob (PN 4256) for the ESO
calibration chamber and (PN 2036) for AR 3D calibration chamber is tight around
the catheter to create good catheter seal (slightly tug the catheter to see if it moves
easily). Seal knobs should be finger tight in order not to damage the catheter.

2.

If two calibration chambers are connected to the A120 module, make sure that the
unused one is sealed with the appropriate plug (PN 150091) for the ESO calibration
chamber and (PN 150092) for the AR 3D calibration chamber.

3.

Make sure that the calibration chamber clamp nut (PN 1452) for ESO calibration
chamber and (PN 4280) for AR 3D calibration chamber is tight around the
calibration chamber tube (PN 1455) to create a good seal.

4.

Take off the calibration chamber seal knob and inspect the small diameter seal
grommet (PN 1283) for ESO calibration chamber and (PN 112330) for AR 3D
calibration chamber. Flip the gasket upside down to potentially enable a complete
seal. Replace the gasket if damaged (see Figure 3 on page 13).

5.

AAN/APN catheters only: make sure that the AR balloon fill locations are capped.

6.

Make sure that all hoses connecting the calibration chambers to the A120 module
are tight and the gaskets are making a good seal.

7.

If pressure still doesn’t reach 300 mmHg, power-cycle the system (modules and
computer) and make sure that modules are USB-connected and powered on before
the computer is done booting up, otherwise synchronization and communication
issues may exist between the modules and the computer. Attempt calibration again.

8.

If the inability to successfully pressure-calibrate the catheter persists, contact your
Given Imaging representative.

Error installing HRM catheter: Access Code Invalid
1.

Re-enter the catheter serial number and Key Code and press Install.

2.

If the inability to successfully install the catheter persists, contact your Given
Imaging representative.

Start button in calibration window is grayed out
1.

The pressure reference sensors offset and gain values, in the respective Acquisition
software installation GLOBAL.CFG file, need to be adjusted.

2.

Contact your Given Imaging representative.
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Esophageal Pressure with Impedance (EAZ) catheter presentations
If there is no impedance signal on any channel:

1.

Make sure the A200 is powered on and the impedance connector is attached.

2.

Open the ManoScan acquisition software and make sure an EAZ catheter is selected
and the Use EAZ as EAN checkbox (in the Select Source screen) is not selected.

3.

USB communication data light on the A200 module is ON (or flickering).

4.

If the USB communication data light on the A200 module is OFF the computer is
not detecting A200.
a. Close the ManoScan Acquisition software.
b. Unplug and then plug back in the A200 module USB cable. Open the software
and check for the impedance signal.
c. Or, power cycle both computer and modules, making sure to turn on the
modules before the computer. Open the software and check for the impedance
signal.

5.

Verify presence of Z signal by placing the catheter in a basin with tap water or saline
solution after a successful pressure calibration and prior to patient intubation.


6.

Note
The impedance data does not appear if ManoShield is used or if the
Use EAZ as EAN checkbox (in the Select Source screen) is selected.

Should the inability to successfully display an impedance signal persist, contact
your Given Imaging representative.

If there is no impedance signal on some channels:

1.

Make sure that all channels show an impedance signal (purple color) when the
catheter is placed in a basin of saline solution.

2.

If any do not, and the problem persists, contact your Given Imaging representative.

3D Anorectal (AAD) catheter presentations
If pressure doesn’t build to 300 mmHg:

1.

Make sure that the AR 3D and standard HRM catheter pressure calibration chamber,
and the orange and green connector hosing are securely T-connected, plumbed
together, and attached to the A120 module. The AR 3D pressure calibration
chamber will not work by itself.

2.

Make sure both pressure calibration chamber knobs are tight around the catheter and
the plug and the balloon fill hoses are securely connected between the probe and the
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modules. Check the 3-way stopcock to ensure the syringe connection point is closed
off and there is free passage of pressure between the probe and module.
3.

Make sure that the ManoShield AR 3D collar is snapped in place on the probe to
make a good seal with the AR 3D pressure calibration chamber. Refer to the
ManoShield AR 3D instruction card.

4.

If pressure still doesn’t reach 300 mmHg, power cycle the system (modules and
computer) and make sure that modules are USB connected and powered on before
the computer is done booting up, otherwise synchronization /communication issues
may exist between the modules and the computer. Attempt calibration again.

5.

If the inability to successfully pressure calibrate the catheter persists, contact your
Given Imaging representative.

If AR 3D catheter does not calibrate:

1.

If different sensors fail on multiple calibration attempts, verify there are no twists or
wrinkles in sheath and re-tune the probe.

2.

If all sensors in a row or column fail, verify that the cables linking the A300 and the
A120 are very tight; this requires a flat head screw driver.

3.

If Element B error message is displayed (balloon sensor calibration error):
a. Refer to the ManoShield AR 3D instruction card.
b. Make sure stopcock is in correct position.
c. Add 1 cc of air to balloon to enable balloon compression during pressurization.
d. Note the balloon pressure profile during calibration; if it builds then plummets
well before the pressure drops on the body of the catheter, there is an air leak
between the balloon luer connection on the catheter and the A120 module.
e. Tighten the luer connection on the distal tip of the probe; be careful not to
introduce twists in the sheath.
f.

4.

If there is no on-screen response from the balloon sensor, remove the purple
luer connection from back of the A120, attach the luer syringe, lightly depress
the plunger, and look for an increase in the balloon pressure signal on the
screen. If the pressure increases, replace the luer connection with a new one.

Should the inability to successfully pressure calibrate the catheter persists, contact
your Given Imaging representative.
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ManoScan Software Problems
Display is not scrolling and/or tuning is stuck at 0%:

1.

Close acquisition program, power-cycle the A120 module for at least 10 seconds,
and then wait another 10 seconds after turning on the A120 module before launching
the software.

2.

Make sure another catheter is not plugged into the A120 module while the AR 3D
catheter is connected to the A300 module.

3.

If the issue persists, contact your Given Imaging representative.

ManoScan opens in Simulation Mode:

1.

Verify the USB cable connections between the modules and the PC with the
corresponding device driver detection in the Windows OS Device Manager.

2.

Verify that the Windows user account is an Administrator account (default
ManoScan PC user login is an Admin account). If not, make sure that users have
read/write capability enabled to the folder where ManoScan is installed, or there
may be issues writing to the program file directory and saving studies.

3.

If the issue persists, contact your Given Imaging representative.
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Chapter 8

Technical Specifications

Electromagnetic Compatibility Declaration
(EN 60601-1-2)
This equipment has been tested and found to comply with the limits for medical devices to
EN 60601-1-2. These limits are designed to provide reasonable protection against harmful
interference in a typical medical installation. However, there is no guarantee that
interference will not occur in a particular installation. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to other devices in the vicinity. If this
equipment does cause harmful interference to other devices, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:
•

Reorient or relocate the receiving device.

•

Increase the separation between the equipment.

•

Connect the equipment into an outlet on a circuit different from that to which the
other device(s) are connected.

•

Consult the manufacturer or field service technician for help.

Guidance and manufacturer’s declaration for electronic emissions appear in the following
tables:
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Table 1. Electromagnetic emissions

The ManoScan system is intended for use in the electromagnetic environment specified below. The
customer or the user of the ManoScan system should assure that it is used in such an environment.
Emissions test

Compliance

Electromagnetic environment –
guidance

Conducted Emissions Group 1; Class A
EN/IEC 60601-1-2:2015 - 0.15
MHz – 30.00 MHz
Radiated Emissions

Group 1; Class A
EN/IEC 60601-1-2:2015 – 30.0
MHZ – 1000 MHz

Power Line
Harmonics

EN61000-3-2:2006 – Up to 40th
Harmonic

Power Line Flicker

HRM: EN61000-3-3:1995 /
A2:2005 – Less than or equal to
4% Maximum Relative Voltage
Change; Value of D(T) less than
or equal to 3% for more than
200 ms

The ManoScan system is suitable for use
in all establishments other than domestic
and those directly connected to the public
low-voltage power supply network that
supplies buildings used for domestic
purposes

Table 2. Electromagnetic immunity

The ManoScan system is intended for use in the electromagnetic environment specified below. The
customer or the user of the ManoScan system should assure that it is used in such an environment.
Immunity test

Compliance level

Electromagnetic environment –
guidance

Electrostatic
Discharge Immunity

IEC 61000-4-2: 1995 / EN/IEC
60601-1-2:2015 – Air discharge
- 15 kV; Contact discharge 8 kV

Floors should be wood, concrete or
ceramic tile. If floors are covered with
synthetic material, the relative humidity
should be at least 30%.

RF Radiated Fields
Immunity

HRM: IEC 61000-4-3:2006
EN/IEC 60601-1-2:2015 –
Radiation Field Strength of
3V/m from 80-2700 MHz (80%
AM @ 1 kHz)
9 V/m to 28 V/m (for 15 specific
frequencies)

Portable and mobile RF communications
equipment should be used no closer to
any part of the ManoScan system,
including cables, than the recommended
separation distance calculated from the
equation applicable to the frequency of
the transmitter. See Note 1 below table.
Interference may occur in the
vicinity of equipment marked
with the following symbol:

Electrical Fast
Transient Immunity

Lightning Surge
Immunity

ManoScan

HRM: IEC 61000-4-4:2004 +
Corrigendum 1: 2006; Level I /
EN/IEC 60601-1-2:2015; Power
line pulses of +/- 2kV direct; I/O
line pulses of +/- 1 kV
IEC 61000-4-5:2005 /
EN/IEC 60601-1-2:2015; Power
line surges of +/- 2kV common;
+/- 1kV differential mode
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Table 2. Electromagnetic immunity (continued)

The ManoScan system is intended for use in the electromagnetic environment specified below. The
customer or the user of the ManoScan system should assure that it is used in such an environment.
Immunity test

Compliance level

Electromagnetic environment –
guidance

RF Common Mode
Immunity

HRM: IEC 61000-4-6:2003/
A1:2004/A2:2006 / EN/IEC
60601-1-2:2015; Level I; 150
kHz – 80 MHz @ 3 Vrms and
6 Vrms in ISM bands; 1 kHz
80% amplitude modulated

Portable and mobile RF communications
equipment should be used no closer to
any part of the ManoScan system,
including cables, than the recommended
separation distance calculated from the
equation applicable to the frequency of
the transmitter. See Note 1, below.
Interference may occur in the
vicinity of equipment marked
with this symbol:

Power Frequency
Magnetic Field
Immunity

IEC 61000-4-8: 1993 / A1:2000
/ EN/IEC 60601-1-2:2015;
Level I; Helmholtz coil @ 50 Hz
and 60 Hz to 30 amps (rms) per
meter

Power frequency magnetic fields should
be at levels characteristic of a typical
location in a typical commercial or
hospital environment.

Voltage Dips and
Short Interruptions

IEC 61000-4-11:2004 / EN/IEC
60601-1-2:2015; Level I;
Voltage Dips:
100% drop, 0.5 periods at 0,
45, 90, 135, 180, 225, 270, 315
degrees; 100% dip, 1 period;
30% dip, 25/30 period.
Interruptions:
100 drop, 5 seconds.

Mains power quality should be that of a
typical commercial or hospital
environment. If continued operation of
ManoScan is required during power
mains interruptions, power the
ManoScan system from an
uninterruptible power supply or a battery.

Note 1:
Recommended separation distances are:
• 0.15 – 80 MHz: D = 3.5√P



•

80 – 800 MHz: D = 1.2√P

•

0.8 – 2.5 GHz: D = 2.3√P

where P is the maximum output power rating of the transmitter in
watts (W) according to the transmitter manufacture and D is the
recommended separation distance in meters.

ManoScan
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ManoScan HRM
Hardware Specifications
ManoScan System Cart Power Isolation Station
Warning
To avoid risk of electric shock, this equipment must only be connected
to a mains supply with protective earth. Do not position the system in a
way that would make it difficult to disconnect the system from the
mains power supply.

!

The ManoScan System Cart power isolation station specifications:
Power

600 VA

Input Voltage

115/ 230 VAC @50 / 60 Hz

Input Current

5.2 Amps / 2.6 Amps

Input Voltage Configuration

115 or 230 VAC

Output Voltage

115/230 VAC

Outlet Connectors

6 IEC 320 connectors

Electronic and Pressure Interfaces for ManoScan System PC
Typical interfaces to the ManoScan System PC are shown in the following figures (see
Figure 34 and Figure 35). The connector layout may vary depending on the PC model.
Consult the provided PC documentation for specific connector layouts.
Devices that are connected to a general network during procedure must have isolation.
PC Power Requirements

ManoScan

power supply wattage

240W

AC input voltage range

90 to 240 VAC

AC input current (low AC / high AC range)

4.0 Amps / 2.0 Amps

AC input frequency (low AC / high AC range)

47 Hz / 63 Hz

63

User Guide

PC Back Panel Connectors

1

2

3

4

8

5
6
7
10

9

11
12

Figure 33. ManoScan system computer interfaces
Back Panel Connectors

ManoScan

1

keyboard connector

7

network activity light

2

mouse connector

8

USB ports (6)

3

serial connector

9

line-in / microphone connector

4

VGA connector

10

line-out connector

5

link integrity light

11

WiFi card

6

network connector

12

video port connector

64

User Guide

1

2

3
5

4
6

7

8

10
9
Figure 34. ManoScan system computer interfaces
Back Panel Connectors

ManoScan

1

link integrity light

6

serial connector

2

line-out connector

7

VGA connector

3

line-in / microphone connector

8

parallel connector

4

network connector

9

WiFi card

5

USB ports (6)

10

video port connector
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ManoScan System Modules
The electronic interfaces to the modules are shown below (see Figure 35 through
Figure 38).
The module power requirements are:
• A120 and A200 modules: 90-230 Volts AC, 50/60 Hz, 40 VA max
• A300 module: powered by the A120 module
USB type B, data
connection to PC

main power receptacle
(IEC 60320-C6)

Figure 35. Electronic interfaces to the A120 module
main power receptacle
(IEC 60320-C6)

USB type B, data
connection to PC

Figure 36. Electronic interfaces to the A200 module

Figure 37. Electronic interfaces to the A300 module

ManoScan
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Figure 38. ManoScan module pairing to HRM catheter with device
names and part numbers

Modular Enhancements
System or Modular Electronics
Enhancement

Modality

Software

Catheters

ManoScan

HRM: ESO

ManoScan 3.0
ManoView ESO

ManoScan ESO (EAN)
ManoScan ESO SD,
Regular (EAS)
ManoScan ESO SD,
Small (EPS)

HRM: AR

ManoScan 3.0
ManoView AR

ManoScan AR, Regular
(AAN)
ManoScan AR, Small
(APN)

A120 (base
pressure
module)

ManoScan
Impedance (Z)

A200
(impedance
module)

HRM: ESO Z

ManoScan 3.0
ManoView ESO

ManoScan ESO Z (EAZ)

ManoScan 3D

A300 (3D
module)

ESO 3D

ManoScan 3.0
ManoView ESO

ManoScan ESO 3D
(EAY)

AR 3D

ManoScan 3.0
ManoView AR

ManoScan AR 3D (AAD)

ManoScan
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Workstation Dimensions
• footprint: 74 cm wide x 69 cm deep x 99 cm high) (29" x 27" x 39") to table top;
add 38–61 cm (15–24") height to accommodate adjustable 17" monitor
• weight: approximately 140–147 kg (310–325 pounds)
Data Acquisition Modules
• A120 ManoScan high-resolution manometry
• A200 ManoScan ESO Z high-resolution manometry
• A300 ManoScan 3D high-definition manometry
Portable Cart
The cart includes adjustable shelves, large lockable wheels (5" minimum diameter),
and an additional storage drawer. In addition, the cart contains:
• Microsoft Windows platform PC with:
• WiFi, LAN, and color printer (600 dpi minimum)
• Flat panel color monitor with touch screen (17" minimum), articulating monitor
arm, and keyboard and mouse controls
• Power:
• Data acquisition and power conditioning unit rated at 90 to 230 VAC, 50/60 Hz,
40 VA Max
• Patient isolation transformer with available expansion power ports rated at 100–
120 / 220–240 VAC, 50/60 Hz, 600 VA maximum
Transportation, Storage, and Operating Ranges
The ManoScan system must be transported and stored in conditions within these ranges:
Temperature

Relative
Humidity

Altitude

Transportation and Storage

-30° C to +60° C (-22° F to +140° F)

Catheter Operating

+10° C to +40° C (+50° F to 104° F)

Module Operating

+10° C to +35° C (+50° F to 95° F)

Transportation and Storage

15% to 90% RH

Operating

20 to 80% RH

AC Input Current (low AC /
high AC range)

4.0 Amps / 2.0 Amps

Transportation and Storage

-15.2 m to 10668 m (-50 ft to 35,000 ft)

Operating

-15.2 m to 3048 m (-50 ft to 10,000 ft)

Atmospheric
Pressure

ManoScan

70kPa - 106kPa
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Recommended Computer Requirements
Item

Minimum

Recommended

CPU

Intel Core 2 Duo 1.86 GHz

Intel Core i3 3.3 GHz or higher

RAM

1 GB

2 GB or more

hard disk

1 GB available

40 GB or more for ManoScan V

CD-ROM drive

(required)

video adapter

24-bit color, 1024x768

USB 2.0 support

(required)

operating system

Windows 7

Windows 8 or 8.1

Microsoft Word

Word 2003

Word 2007 or Word 2010 (with
Microsoft Save as PDF add-in)

Adobe Acrobat
Reader

(required)

ManoScan
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Catheters and Probes
The non-single-use catheters and probes are reusable solid-state tactile pressuresensing technology devices.
Standard Diameter: 12 pressure-sensitive segments circumferentially distributed on
~4.2mm diameter
• ESO catheter: esophageal regular or extended tip, 36 channels, 432 pressure
points, 10mm on center spacing
• ESO Z catheter: esophageal + impedance
• 36 channels, 432 pressure points, 10 mm on center spacing
• 18 channels, 20 mm on center spacing
• AR catheter, regular: anorectal, 12 channels, 144 pressure points, 6 mm on center
spacing
• AR catheter, small: anorectal, 8 channels, 96 pressure points, 6 mm on center
spacing
Small Diameter: 36 channels with 16 pressure-sensitive segments circumferentially
distributed on ~2.75 mm diameter (576 total points)
• ESO catheter, SD regular: small diameter esophageal, 10 mm on center spacing
• ESO catheter, SD small: small diameter esophageal, 7.5 mm on center spacing
3D Sensing:
• ESO 3D catheter: 3D esophageal, 128 individual pressure-sensing channels; 12
3D sensing rings evenly aligned axially in the LES region, each consisting of 8
sensors circumferentially distributed along the radius, giving 96 individual
sensing points at 7.5 mm on center spacing and ~1.6 mm (~45 deg.) spacing
between adjacent radial sensors; 32 standard diameter sensors at 10 mm on center
spacing, giving 384 additional pressure points covering the remainder of the
esophagus; ~4.2 mm diameter
• AR 3D probe: 3D anorectal, 256 individual pressure-sensing channels; 16 3D
sensing rings evenly aligned axially, each consisting of 16 sensors
circumferentially distributed along the radius; 4 mm spacing between adjacent
sensor rings, ~2 mm (~22.5 deg.) spacing between adjacent radial sensors; ~10.75
mm diameter; sensing length ~7 cm
Accessories:
• ManoShield ESO latex-free disposable sanitary sheath
• ManoShield ESO SD latex-free disposable sanitary sheath
• ManoShield AR latex-free disposable sanitary sheath and integrated 400 cc
balloon
• ManoShield AR 3D latex-free disposable sanitary sheath and integrated 400 cc
balloon
• Anorectal latex-free balloons (150 cc, 400 cc, and 600 cc)

ManoScan

70

User Guide

Frequency response: capability >100 Hz; system response limited by catheter scan
rate shown below:
• minimum scan rate: 40 Hz regular and small ESO, 100 Hz regular AR, 150 Hz
small AR, 14 Hz AR 3D, 21 Hz ESO 3D
• output resolution: 0.1 mmHg
• sensor channel uniformity: 1σ ≤ 1 mmHg at 0–50 mmHg; 1σ ≤ 2 mmHg at 51–
300 mmHg
• sensor non-linearity calibration residual: +/- 2 mmHg (0–100 mmHg), 2% of
reading (100–300 mmHg) [mean]

Software
Esophageal: ManoScan 3.0 Acquisition and ManoView ESO Analysis
Anorectal: ManoScan 3.0 Acquisition and ManoView AR Analysis
The software contains the following features:
• Temporal display: high-resolution contour with instant switching to conventional
line traces
• Real-time display: pressure profile and color bar modes superimposed on
anatomy of esophagus or anorectum
• Real-time 3D display: free rotating real-time 3D cylindrical pressure display with
instant switching to vector volume and 2D views
• Interface: keyboard and mouse
• Patient data review: replay (like a movie) and static (scroll-through) file review
modes; analysis tools available in each mode
• In-procedure support: split screen (allows review of data from earlier in recording
while procedure is occurring)
• Analysis tools: built-in functions provide quantitative measures of pressures,
velocities, and event periods; graphical tools facilitate localization of sphincters
and PIP; automated and manual analysis modes with user-configurable and onthe-fly report formatting:
• Chicago Classification Scheme Support
• 3D only: asymmetry calculations and plots
• Operator support: automated clinical protocol that steps technician through setup,
calibration, and data collection (manual mode also available for investigatory or
other special uses)
• Training support: emulation mode supports use of all system features using actual
patient data for training purposes
• Educational support: simulation mode provides graphic high resolution playback
of normal and pathological motility with anatomical background

ManoScan

71

User Guide

Specification of High Resolution and 3D Manometry Catheters
Probe Type

Number of
Sensors

Spacing between
Sensors

Diameter

ManoScan ESO Catheter (EAN)

36

10 mm

4.2 mm

ManoScan ESO Catheter with
Extended Tip (EAN)

36

10 mm

4.2 mm

ManoScan ESO Catheter, SD Small
(EPS)

36

7.5 mm

2.75 mm

ManoScan ESO Catheter, SD
Regular (EAS)

36

10 mm

2.75 mm

ManoScan ESO Z Catheter (EAZ)

Pressure: 36
Impedance: 18
channels
(19 rings)

Pressure: 10 mm
4.2 mm
Impedance: 20 mm

ManoScan ESO 3D Catheter (EAY)

128 (including 32 Proximal to Distal:
HRM sensors and 10mm (between
96 3D sensors)
HRM sensors);
7.5 mm (between
3D sensors)
Circumferential
(within 3D sensor
area): 1.5 mm

4.2 mm

ManoScan AR Catheter, Small (APN) 8 (including 1
balloon sensor)

6 mm

4.2 mm

ManoScan AR Catheter, Regular
(AAN)

12 (including 2
balloon sensors)

6 mm

4.2 mm

ManoScan AR 3D Probe (AAD)

257 (including 1
balloon reference
sensor)

Proximal to Distal:
4 mm
Circumferential:
2 mm

10.5 mm

ManoScan
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Symbols on Package Labeling
Refer to the device to see which symbols apply to this product.
Symbol

Symbol
number

Symbol title

Description

MDD 93/42/
EEC, Annex
XII1

CE marking

To indicate conformity with the
provisions of MDD 93/42/EEC
Directive.

ISO 15223-12,
Clause 5.1.2

Authorized
representative in
the European
Community

Indicates the authorized representative
in the European Community.

ISO 15223-12,
Clause 5.3.1

Fragile, handle
with care

Indicates a medical device that can be
broken or damaged if not handled
carefully.

ISO 15223-12,
Clause 5.4.4

Caution

Indicates the need for the user to
consult the instructions for use for
important cautionary information such
as warnings and precautions that
cannot, for a variety of reasons, be
presented on the medical device itself.

ISO 15223-12,
Clause 5.4.3

Consult
instructions for
use

Indicates the need for the user to
consult the instructions for use.

ISO 15223-12,
Clause 5.1.5

Batch code

Indicates the manufacturer's batch
code so that the batch or lot can be
identified.

ISO 15223-12,
Clause 5.1.7

Serial number

Indicates the manufacturer's serial
number so that a specific medical
device can be identified.

ISO 15223-12,
Clause 5.1.6

Catalogue
number

Indicates the manufacturer’s catalogue
number so that the medical device can
be identified.
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73

User Guide

ISO 15223-12,
Clause 5.1.1

Manufacturer

Indicates the medical device
manufacturer, as defined in EU
Directives 90/385/EEC, 93/42/EEC and
98/79/EC.

IEC 60601-13,
Table D.1,
Symbol 4

Direct current

To indicate on the rating plate that the
equipment is suitable for direct current
only.

IEC 60601-13,
Table D.1,
Symbol 1

Alternating current

To indicate on the rating plate that the
equipment is suitable for alternating
current only

Directive
2012/19/EU,
Annex IX4

Separate
collection for
electrical and
electronic
equipment

Do not throw in trash. Dispose
according to local regulations.

ASTM F25035

Magnetic
Resonance (MR)
unsafe

Keep away from magnetic resonance
imaging (MRI) equipment.

ISO 15223-12,
Clause 5.3.4

Keep dry

Indicates a medical device that needs
to be protected from moisture.

ISO 15223-12,
Clause 5.3.7

Temperature limit

Indicates the temperature limits to
which the medical device can be safely
exposed.

CAN/CSAC22.2 No.
60601-16

CSA certification
Mark

Products bearing this mark have been
tested and certified in accordance with
applicable U.S. and Canadian electrical
safety standards.

ISO 15223-12,
Clause 5.1.4

Use by date

Indicates the date after which the
medical device is not to be used.

ISO 15223-12,
Clause 5.4.2

Do not re-use

Indicates a medical device that is
intended for one use, or for use on a
single patient during a single
procedure.
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1

IEC 60601-13,
Table D.1,
Symbol 19

Type BF applied
part

To identify a type BF applied part
complying with IEC 60601-1.

IEC 60601-127

Non-ionizing
electromagnetic
radiation

To indicate generally elevated,
potentially hazardous, levels of nonionizing radiation, or to indicate
equipment or systems e.g. in the
medical electrical area that include RF
transmitters or that intentionally apply
RF electromagnetic energy for
diagnosis or treatment.

IEC 60601-13,
Table D2,
Symbol 10

Follow instructions
for use

Refer to instruction manual or booklet

ISO 15223-1,
Clause 5.3.8

Humidity limitation

Indicates the range of humidity to which
the medical device can be safely
exposed.

ISO 15223-1
Clause 5.3.9

Atmospheric
pressure limitation

Indicates the range of atmospheric
pressure to which the medical device
can be safely exposed.

21 CFR
801.1098

Prescription only

Prescription device

93/42/EEC, Medical Device Directive.

2

ISO 15223-1, Medical devices — Symbols to be used with medical device labels, labelling and information to be supplied.

3

IEC 60601-1, Medical electrical equipment — Part 1: General requirements for basic
safety and essential performance.

4

Directive 2012/19/EU, Waste electrical and electronic equipment (WEEE).

5

ASTM F2503, Standard Practice for Marking Medical Devices and Other Items for Safety
in the Magnetic Resonance Environment.

6

CAN/CSA-C22.2 No. 60601-1 Medical Electrical Equipment - Part 1: General Requirements for basic safety and essential performance.

7

IEC 60601-1-2, Medical electrical equipment — Part 1-2: General requirements for basic
safety and essential performance — Collateral standard: Electromagnetic compatibility —
Requirements and tests.

8 CFR 801.109, Labeling- Prescription devices
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